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Introduction to Auto Complete Work Service

We are currently updating our site; thank you for your patience.

COMPANION APPLICATIONS

INTRODUCTION TO BPO AUTO COMPLETE
WORK SERVICE

BPO Auto Complete Work Service (RSI_AutoCompleteService) is installed,

configured and managed on your server

This service monitors Calls in order to set them to complete, where all under-

lying requirements have been met:

e All Call underlying work orders must be set to Complete or

Closed
* All Requested Parts should be issued and all Requested SubCon-

tract service should be completed.

The Work Order document will be emailed to the Call Contact person when

the Call is set to Complete via this service.

INSTALLATION

* Double click on the 'CompletedWork_Setup' install file.
* Note: Check that you have the latest version.

BPO_Comple

tedWork_v2.0

0.1 %64 Setu
p.msi
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* The Installation Wizard will open.
* Click on Next.

| BPO RS Completed Wo — X
Welcome to the BPO RSI Completed Work Setup .
Wizard =B

The inztallerywill guide vou through the steps required to install BP0 BS1 Completed Y ork on your
computer.

WARMIMG: Thiz computer program iz protected by copyright law and intermational treaties.
Unauthorized duplication o distibution of this program, or any portion of it, may result in severs/civi
aor criminal penalies, and will be prozecuted ta the masimurn extent pozsible under the law.

Eancél . < Back

1. The default location for installation is:

C:\Program Files\CO3 Technologies (Pty) LTD\BPO RSI Com-
pleted Work\

It is recommended that you keep this default location. Keeping a

standard will make upgrades easier.

2. Ensure that Everyone is selected for the install.
3. Click on the Next button.
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ﬁ BP O RSl Completed Work — >

Select Installation Folder

The ingtaller will ingtall BPO RS Campleted 'wfark ta the fallowing folder.

Taoinstall in thiz folder, click "Mest'. Tao nstall to a different falder, enter it below ar click "Browse"',

Eolder: A

C:5Program Filez\CO3 Technalogies [Pyl LTDAEPO BSI Completed i Browse...

Dhgk. Cost...

Install BPFO RS| Completed Wark for vourself, or for anyone who uses this computer:

VEMIONE H

() Just me

Cancel .. . < Back ..

1. The installer will ask you to Confirm Installation.
2. Click on Next to start the installation.
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ﬁ BPO RSl Completed Work -- o
Confirm Installation | <) [
=

The ingtaller iz ready to inztall BPO BS1 Completed 'work. on pour computer.

Click "MNest'" ta start the installation.

| Cancel | | ¢ Back | I Mest »

1. The BPO RSI Completed Work installation will begin.
2. Wait for it to be completed.
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‘.ﬁ BPO RSl Completed Work

Installing BPO RSI Completed Work | «——@) [

BPO RSl Completed “Work iz being installed.

Fleaze wait...

i Cancel i g Eack

Mt =

1. Once Installation is Complete.
2. Click on Close.
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ﬂ BPO RSl Completed Work — >
Installation Complete 4—’ e
.l""";‘l o I

&

BPO RSl Completed ‘\Waork. hag been successfully installed.

Click "Cloze" to ext.

Pleaze uze Windows Update to check for any critical updates to the MET Framework.

Cancel < Back

ENVIRONMENT CONFIGURATION

1. Inyour File Explorer, search for the following file location:

C:\Program Files\CO3 Technologies (Pty) LTD\BPO RSI Com-
pleted Work

2. Right click on the Envn.xml file.
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| M O=l8 _ o %
Home Share View e
B U o Cut x EI' 0 Mew item = D ) open~ [ selectal
w-! Copy path « ) ﬂEasy access v D’Edit :: Select none
Pinto Quick Copy Paste — Move Copy Delete Rename MHew Properties
access I:I Paste shortcut to- tor - folder - £ History ﬁ‘?lnvertse\ection
Clipboard Organise New Open Select
< ¥ ‘Pl <« Program Files » CO3 Technologies (Pty) LTD » BPO RSl Completed Work v O I Search BPO RSl Completed W... 0
Windows (C:) i MName Date modified Type
= Documents o |4 DevExpress.XtraPivotGrid.v18.2.dll 15-05-2019 2:36 PM Applice
BPO_Upgrade BASE %] DevExpress.XtraPrinting.v18.2.dll 15-05-2019 2:56 PM Applic:
BPO2_v2.3.0.4_Scripts m DevExpress.XtraReportsv18.2.dlI 15-05-2018 2:56 PM Applic:
CRM.000.012 Basics Cases DevExpress.XtraReports.v18.2 Extensions....  15-03-2019 2:56 PM Applic:
& i i 5.05-2010 2.5 ice
% DatimEres D DevExpress.XtraRichEdit.v18.2.d1l 15-05-2019 2:56 PM Applic
E| DevExpress.XtraRichEdit.v18.2.Extensions...  13-03-2019 2:56 PM Applic:
[ Desktop DevExpress.XtraTreelist.v18.2.dIl 15-05-2019 2:56 PM Applic:
@ O3 Technologies (Phy)Ltd DevExpress.KtraVerticalGrid.v18.2.dll 15-05-2019 2:56 PM Applic:
a Abigailm DevExpress.KtraWizard.v18.2.d1l 15-05-2019 2:56 PM Applict
Sndis 2 dxWorkOrder.dll 16-07-2019 10:13 AM Applic:
.—PI || Envnaxml I19-D?-2019 1:00 PM KML Dy
.dotnet
£ u MetReports.dil 19-07-2019 1:01 PM Applic:
KRB0 0 [&] RSI_CompletedWork.exe 22-07-20191247PM  Applic:
AppData D RSI_CompletedWork.InstallState 09-12-2019 3:31 PM INSTAL
@ CO3 Technologies (Pty)Ltd [ staticDatasxml 19-07-2019 1:00 PM XML Dv
[25 Contacts D WorkSDE.dil 19-07-20191:01 PM Applice w
B Meckton N %
4iiterns 1 item selected 327 bytes

1. The File menu will open.
2. Select to Edit with Notepad++.
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| | = | BPO RSI Completed Work .\‘ — m] X
Home Share Wiew A o
Oiz., BE X< A =
) =] Copy path Edit with Microsoft Expression Web 4 B
Pinto Quick Copy Paste _ Move Copy Delete Rename Mew
access lﬂ Paste shortcut tor tow i folder 7-Zip > pction
Clipboard Organise IU Edit with Notepad++ ‘\ I
« v 4 <« Program Files » C0O3 Technologies (Pty] LTD » BPO RSI Comple| £ Scan with Windows Defender... \. ]
|& Share
& Downloads A Name ] pe
: = : Open with >F-
x Favauts l:‘] DevExpress.x Restore previous versions pplicz
Intel u DevExpress. Xt pplice
& Links ] DevExpress it > pplice
MicrosoftEdgeBackups % DevExpress.it Cut pplice
: %] DevExpress.Xt Copy pplic:
JI Music %
DevEx L KH lic:
& OneDrive i Create shortcut il fc
|j DevExpress.xt pplic:
OneDrive for Business — Unsynced Changes D e g ;}elete e
= pi. = ename
=] Pictures [#] DevExpress.xt pplic:
RDPG [#] dxWorkOrder. Properties pplice
Roaming [ Ervnaemi TI7= 2070 00 P ML Dy
#P Saved Games B NetReports.dil 19-07-2019 1:01 PM Applict
B Searches [®E] RSI_CompletedWork.exe 22-07-2019 12:47 PM Applic:
e .
P [] RsI_CompletedWork.InstallState 08-12-2019 3:31 PM INSTAL
racin =
J [] StaticDataxml 19-07-2019 1:00 PM XKML Dy
B Videos WorksDK.dll 18-07-2012 1:01 PM Kpphiciig
& This PC v < X
45items  1item selected 327 bytes =]

The xml file will open in Notepad++.

1. Environment: Type in the environment name, as defined for this data-
base, in the Service Manager.

2. Interval Amount Type in the time interval amount for this service to
run e.g. 2, 10, 60.

3. Interval Unit Type in the time unit the interval amount e.g. min
(minutes), hrs (hours) day (days).

* In this example, the service will run once every 2 minutes.
4. When you have finished editing the file, click on Save.

SERVICE [ STATIC DATA CONFIGURATION

5. Open the StaticData.xml file.

Help v2024.5.0.7/1.0 - Pg 8 - Printed: 04/07/2024

CO3 Technologies (Pty) Ltd © Company Confidential



cCOO=
Introduction to Auto Complete Work Service

@’ *CA\Program Files\CO3 Technologies (Pry) LTOMBPO RSl Completed Work\Envnaml - Notepad++ — O >

File Edit Search View Encoding Language Settings Tools Macro Run Plugins  Window 7 X

oBeRGa s mbiae nnlea BRI Ez@has(E

I Ervefin E3] B StabeOeta L‘.i||

B

<%xml wversion="1.0" encoding="utf-8" standalons="yes"?>
<NewDataSet>
<tblEnvironment Sys="ComplstedWork">
<Environment Environment>

4Interval§mount!2 / Intervalhmount}ﬂl_.
O&ENT}——}

<IntervalUnitiming/IntervalUnit> -
<! -——<COMMENT>Valid IntervalUnits are: sec, min</C
</tblEnvironment>
</NewDataSet>

(fel== RN N B -

length: 324 lines: 9 Ln:5 Col:22 Sel:0|0 Windows (CRLF)  UTF-8 IMN5

1. Environment: Type in the environment name, as defined for this data-

base, in the Service Manager.

In order to email the Work Order to your client, you need con-

figure these email settings:

2. SMTP Server: Type in your company's SMTP server details

3. Sender Mail Address: Type in the email address that should be used
for the Sent From address.

4. Use Sender Mail Address: Select Yes to display the Sent From
address.

5. Copy To Address: Type in the email address(es) that should be copied

in on the email when it is sent.
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6. Mail Subject and Mail Body: These are populated with defaults, but
you can type in any changes, as required.

7. When you have finished editing the details, click on Save.

8. Close Notepad++.

@{ C\Program Files\CQ3 Technologies {Pty) LTEBABPO RSl Completed Worlk!\ StaticData.xml - Notepad++ = (m}
File Edit Encoding Language Settings Tools Macre Run  Plugins Window 7 ‘/ X
siBe iR smDoe s 2% GRS ENEhoe | BENE@

B Envnoml &) [ StaticData.xml E"
<?xml version="1.0" encoding="utf-8" standalone='"yes"?2>
<NswDataSst>
g <tblEnvironment Sys="CompletedWork">
<fldEnvironmentiDEVE/fldEnvironment>
CEldsmtpServeriismtp.afrihost.co.zaF/fldsmtpServer>4__°
<£ldPortNoi25k/EldFortoy @ —
<fldSenderMailiddressinoreplyfdomain.co. zal(/fldsanderM.ailAddreas><_.
<EldUseSBndB:MailAddressj!est.l' fldUseSenderMailiddress>
=g < f1 dCopyToAddressisupport@co3.co.zaf/fldCopyToAddress> .
<fldMailSubjectiWork Completedi/fldMailSubiect>
/<Eld.MailBGdy Please find attached the document detailing the work und.ertaken.l(/fldMailBr:dy>
4thl]~:nviranmant>
L</NewDataSet>

~1 @ oen B b

R

eXtensible Markup Language file length: 615 lines: 13 Ln:7 Col:41 Sel:0|0 Windows (CRLF}  UTF-8-BOM INS

START SERVICE

Once you have done the service configuration, you need to start the service

from the Administrative Tools > Services screen in Windows.

* Select the Windows icon in your taskbar.

1. Search for and single click on Windows Administrative Tools.

The Tools menu will expand.
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2. Search for and single click on Services.

B windows Accessories

B Windows Administrative Tools

Component Services 0 E H
-

) Computer Management Visual Studio
Outlook File Explorer 2007
Defragment and Optimise Drives

Disk Clean-up g ] gl !

Event Viewer -~ . Micmsu_ﬂ
Skype Greenshot Publisher Expression...

" Intemet Information Services {115},
Life at a glance

i Intemet Information Services (115)...

L iSCSH Initiator

SQL Server licros: HP Client
Management... S Security

s Local Security Policy
4 ODBC Data Sources (32-bit)

™ ODBC Data Sources (64-bit)

®

Photos. Google Chrome

) Performance Monitor
: ¥ Print Management
Recovery Drive
*  Registry Editor
) Resource Monitor
Services
System Configuration

System Information

1. The Services screen will open.
2. Right click on BPO Completed WO Service.
3. Inthe pop-up menu, click on Properties.
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= O X
File Action View Help
s | m B HE »wnm®n
o Services {Local) || Name - Description Status Startup Type LogOnAs =
'-;‘,':E;Active)( Installer (AxInstSY) Provides User Account Control validation for thei... Manual Local System
L‘:;};Adoba Acrobat Update Service Adobe Acrobat Updater keeps your Adobe softwa..  Running Automatic Local System
?J%Agent Activation Runtime_b338d1b Runtime for activating conversational agent appli... Manual Local System
@AIIJoyn Router Service Routes AllJoyn messages for the local Allloyn clie.. Manual (Trigger Start) Local Service
App Readiness Gets apps ready for use the first time a user signs i... Manual Local System
Application Host Helper Service Provides administrative services for lIS, for examp... Running Automatic Local System
&k Application Identity Determines and verifies the identity of an applicat... Manual (Trigger Start) Local Service
QAPP”(HUDH Information Facilitates the running of interactive applications... Running Manual (Trigger Start) Local System
;‘::éApplicat\on Layer Gateway Service Provides support for 3rd party protocol plug-ins f... Manual Local Service
:;Q;Applicat\on Management Processes installation, removal and enumeration r...  Running Manual Local System
@App}( Deployment Service (AppXSVC) Provides infrastructure support for deploying Stor.., Manual Local System
@ASP.NH State Service Provides suppert for out-of-process session state..  Running Automatic (Delayed Start)  Network Servi
&:{;AssignEdAccessManager Service Start rvice supports kiosk e... Manual (Trigger Start) Local System
ik Auto Time Zone Updater Stop m time zone. Disabled Local Service
. AVCTP service Baiss (Transport Protocol ser...  Running Manual (Trigger Start) Local Service
£ Background Intelligent Transfer und using idle netwo...  Running Automatic (Delayed Start)  Local System
;E:},;Ea:kground Tasks Infrastructure 5 Resme ice that controls whic...  Running Automatic Local System
:;Q;Base Filtering Engine Rectart “E) isaservice that m..  Running Automatic Local Service
'\Qﬁ BitLocker Drive Encryption Service Al Tasks s | Drive Encryption servi... Manual (Trigger Start) Local System
@B\Dck Level Backup Engine Service \ ed by Windows Backu... Manual Local System
:f:&B\uetthh Audio Gateway Service Refresh gateway role of the ..  Running Manual (Trigger Start) Local Service
@B\uetonth Support Service rts discovery and ass...  Running Manual (Trigger Start) Local Service
: Bluetooth User Support Service_b358d1b upports proper functi... Manual (Trigger Start) Local System
& Boni ; Help 4 2
®— . s
«:BranchCache This service caches network content from peers o... Manual Network Servi
L@CapabllltyAccEss Manager Service Provides facilities for managing UWP apps access...  Running Manual Local System i
-za_r L o e R M - W FS ; T
Extended }\ Standard

1. The Properties screen will pop up.

2. Click on the drop-down arrow in the Startup Type field.

3. Select Automatic (Delayed Start) from the menu.
* This setting will ensure the service is restarted if your server

is restarted.
4. Click on OK.
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BPO Completed WO Service Properties (Local Computer) ‘—.

General |ogOn Recovery Dependencies

Service name: BPO_CompletedWork
Display name: BPO Completed WO Service

Description: ‘Manages completed work order reparts for BFO
Path to executable:
"C:\Program Files\C03 Technologies (Pty) LTDAWBPO RS Completed Work

Startup type: | Manual
."" PTG

Manual

] Dizabled
Service status:  SOppeEd

Start | Stop Pauze Resume

You can specify the start parameters that apply when you start the service
from here.

Start parameters: | |

.—>| oK |l Camcal || Ay

The Properties menu will disappear.

1. In the Services screen, you will note that the service Startup Type has
now changed to Automatic (Delayed Start).

2. Right click on BPO Completed WO Service.

3. In the pop up menu, click on Start.
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£y Services = O X

File Action View Help

e |FEBo=HFE »onw

Services (Local) || Mame h Description Status Startup Type LegOnAs ~
:C?EA:tiveX Installer (AxInstSV) Provides User Account Control validation for the i... Manual Local System
:\.‘:}‘;Adoba Acrobat Update Service Adobe Acrobat Updater keeps your Adobe softwa... Running Automatic Local System
QAgent Activation Runtime_b358d1b Runtime for activating conversational agent appli... Manual Local System
'{Q;AHJoyn Router Service Routes Allloyn messages for the local Allloyn clie... Manual (Trigger Start) Local Service
QApp Readiness Gets apps ready for use the first time a user signs i... Manual Local System
'-;‘.:&Application Host Helper Service Provides administrative services for IS, for examp... Running Automatic Local System
kﬂ:é;Application Identity Determines and verifies the identity of an applicat... Manual (Trigger Start] Local Service
E"‘&Appllcatmn Information Facilitates the running of interactive applications ...  Running Manual (Trigger Start] Local System
@EApplication Layer Gateway Service Provides support for 3rd party protocol plug-ins f.. Manual Local Service
R{":«;Application Management Processes installation, removal and enumeration r...  Running Manual Local System
-:‘:.“:éApr Deployment Service (AppXSVC) Provides infrastructure support for deploying Stor... Manual Local System
'{Q}ASP.NET State Service -process session state..  Running Automatic (Delayed Start)  Network Servi
aAsslgnEdAccessManager Service rvice supports kiosk .., Manual (Trigger Start] Local System
‘KAutoT\meZme Updater Stop m time zone. Disabled Local Service
“CLAVCTP service Pattse Transport Protocol ser...  Running Manual (Trigger Start] Local Service
:.‘:V:&Background Intelligent Transfer Service ound using idle netwo...  Running Automatic (Delayed Start)  Local System
k‘_’zﬁ Background Tasks Infrastructure Service i ice that controls whic..  Running Automatic Local System
:\f.:e;Base Filtering Engine Restonl FE) is a service that m...  Running Automatic Local Service
-;’;’:E; BitLocker Drive Encryption Service All Tasks 5> || Drive Encryption servi... Manual (Trigger Start) Local System
“CLBlock Level Backup Engine Service ed by Windows Backu... Manual Local System
'-\Q;EIuatooth Audio Gateway Service Redrechy o gateway role of the ... Running Manual (Trigger Start] Local Service
-\‘%Bluatooth Support Service Properties orts discovery and ass..  Running Manual (Trigger Start] Local Service
k’::e;;BIuatooth User Support Service_b338d1b hap upports proper functi... Manual (Trigger Start) Local System
B : : el d
@— d : T z
“a:BranchCache Is service caches network content from peers o... anua etwork Servi
QCapabllltyAccess Manager Service Provides facilities for managing UWP apps access..  Running Manual Local System .
-;.’ . e iarnaa P S Ly e s . i
Extended )\ Standard

1. The service will now be Running.

2. Close the Services screen.
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& = [}
File Action View Help
Y- EEEN B
Services (Local) || Mame h Description Status Startup Type LegOnAs ~
161 ActiveX Installer (AxInstSV) Provides User Account Control validation for the i... Manual Local System
“ChAdobe Acrobat Update Service Adobe Acrobat Updater keeps your Adobe softwa... Running Automatic Local System
QAgent Activation Runtime_b358d1b Runtime for activating conversational agent appli... Manual Local System
{1 Allloyn Router Service Routes AllJoyn messages for the local Allloyn clie... Manual (Trigger Start) Local Service
{_‘;}App Readiness Gets apps ready for use the first time a user signs i... Manual Local System
Sk Application Host Helper Service Provides administrative services for IS, for examp... Running Automatic Local System
'-\E.."{;Appllcatiun Identity Determines and verifies the identity of an applicat... Manual (Trigger Start] Local Service
¥.};Appl|cat|un Information Facilitates the running of interactive applications ..  Running Manual (Trigger Start] Local System
{,‘?:Applicatinn Layer Gateway Service Provides support for 3rd party protocol plug-ins f.. Manual Local Service
% Application Management Processes installation, removal and enumeration r...  Running Manual Local System
-\.'.:&Appx Deployment Service (AppXSVC) Provides infrastructure support for deploying Stor... Manual Local System
“CLASP.NET State Service Provides support for out-of-process session state..  Running Automatic (Delayed Start)  Network Servi
&}AssignadAccessManagar Service AssignedAccessManager Service supports kiosk e.. Manual (Trigger Start) Local System
: Auto Time Zone Updater Automatically sets the system time zone. Disabled Local Service
'-.‘ié;AVCTP service This is Audio Video Control Transport Protocol ser...  Running Manual (Trigger Start] Local Service
'-.”.:?5 Background Intelligent Transfer Service  Transfers files in the background using idle netwo...  Running Automatic (Delayed Start)  Local System
0} Background Tasks Infrastructure Service Windows infrastructure service that controls whic..  Running Automatic Local System
QEase Filtering Engine The Base Filtering Engine (BFE) is a service that m...  Running Automatic Local Service
-\!.:;%Eith(ker Drive Encryption Service BDESYC hosts the BitLocker Drive Encryption servi... Manual (Trigger Start) Local System
i£1Block Level Backup Engine Service The WBENGINE service is used by Windows Backu... Manual Local System
-\S"@;Bluatouth Audio Gateway Service Service supporting the audio gateway role of the ... Running Manual (Trigger Start] Local Service
01 Bluetooth Support Service The Bluetooth service supports discovery and ass..  Running Manual (Trigger Start] Local Service
'-\,‘_',('&BIuatnnth User Support Service_b358d1b  The Bluetooth user service supports proper functi... Manual (Trigger Start] Local System
l.“.:?;Bonjour Service Enables hardware devices and software servicest..  Running Automatic Local System
% BPO Completed WO Service Manages completed work order reports for BPO Automatic (Delayed Start)  Local System
RS},‘.;Bran(_hCa:he This service caches netwerk content from peers o.. K Manual MNetwork Servi
-\C:E;Capahility Access Manager Service Provides facilities for managing UWP apps access..  Running Manual Local System -
P A P S Ly e s . LSO
Extended)\Standard

CAP.200.001
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